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About this Manual

Notation Conventions

The contents of this manual are classified according to the following symbols.

\1) IMPORTANT

e The “Important” sections contain operating precautions or important topics.
Ensure that you read them.

@ HINT
[- The “Hint"” sections contain procedural suggestions and tips for your convenience. Read them as J
necessary.

Operating Environment

e This manual uses Mac OS X v10.4 screen shots and procedures in the explanations.
The screen shots and procedures may appear slightly different if you are using
another version of Mac OS.

e The displayed screens and procedures may also differ slightly from the examples
depending upon the camera or printer model in use.

e The explanations in this guide are based on the premise that a Canon compact
camera will be used with the software.

Word Searches

This document is provided as an Adobe Reader document. Use Adobe Reader’s Search
functions to find specific words or phrases that you recall but cannot find. To access
this function, in Adobe Reader click the [Edit] menu and select the [Search] option.

If you are using Adobe Reader 8 or later, you can also perform searches with the [Find]
function right on the toolbar.

° " Adobe Reader File Edit View Document Tools Window Help
®606

B g1 /50 (®© ®00% - [ A

Input search text here
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& Features

This page and the next present the basic functions of ImageBrowser as well as some of

its special features.

To Download

~ Downloading

¢ Download images J

(p. 10) ! with a single click.
4
To Print
~ Printing
(p. 13)
y
To View . U :
 Displaying
~ Magnifying Shooting
the Display Information
(p- 21) (p- 21)
~ Comparing ~ Slideshows
Images (p- 34)
.41
(p. 41) )
To Organize
~ Deleting > C.hanging . g @ g
(p. 19) File Names in .
Batches Wl el o
(p. 35) xxx_O x xxx_03
~ Using Star Ratings ~ Using Comments
(p. 37) (p- 37)
~ Performing g~
Searches
(p. 39)
v
Next -
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To Edit

~ Adjusting ~ Red-Eye
Color and Correction
Brightness (p. 23)
(p. 22)

~ Inserting ~ Trimming
Text (p- 22)
(p. 23)

~ Converting
RAW Images

(p. 29)

~ Merging Images
into Panoramas
(p. 28)

~ Formatting ~ Extracting Still

Images as Images from
Wallpaper Movies
(p. 31) (p. 32)
~ Resizing ~ Editing Movies
Images (p- 28) v i b la
.30 T e,
(-30 R
v,
To Connect to a Camera
~ Uploading ~ Configuring My
to a Camera Camera Settings
(p. 46) (p. 44)
~ Controlling Shooting : You can change the
: camera'’s start-up image
IroTz’;he Computer /\(\(b a i and shutter sound.
p- :

To Send Email

~ Attaching .{ You can reduce
Images to Email ! image file sizes.
(p. 33)
v
<| Previous
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The Two ImageBrowser Windows

Download Window/Organizing Window

The following two windows are the main ones used for ImageBrowser procedures.

t)) Download window, which opens when a camera is connected.
O CameraWindow

View of camera images

Canon Utilities
Camera

Transfer Untransferred Images

Operate Images on Camera

You can download all or a selection of images from the connected camera.

e === J
CameraWindow closes and the
screen changes after the images are
downloaded from the camera.

Organizing window for downloaded images.
<7 Main Window e lBnansosty

[-X=X-] | Browsar Window -
l::‘l::z“:::l:::u‘u y — : !! "

V.;:;;I;:nrv ::‘:i‘”:‘” ”":' J C||Ck thIS ICOn

Crvms e Lo in the Dock.

[Favorite Fodders | A Foisars o 0

htrent ez ™ Double-click ...

Cisoor os e : an image.

Eb 20005 17
You can view, edit and print the images in the computer. The Viewer Window that appears

when you view an image.
4

T easy
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Browser Window

How to Display the Browser Window

The Browser Window will display after camera images are TG CETOWSCT
downloaded and CameraWindow closes. You can also display it by

clicking the ImageBrowser icon in the Dock (the bar at the bottom of @

the desktop).

e |f the ImageBrowser icon is not displayed in the Dock, double-click
the Applications] folder, followed by the [Canon Utilities] folder,
[ImageBrowser] folder and the [ImageBrowser] icon.

Names of the Browser Window Parts

.! ImageBrowser File Edit View Internet Window Help I |Brows|$r Arga . X
cons that indicate image properties
| display around thumbnail images, as

Display Modes shown on the bottom left.

Menu Bar I
(Acq\red Images
¥=Show All Images I
¥l Shooting Date ¥ B o
. 28] 2007_05_25 File Name: IMG.
LaSt AcqulrEd |mages 'uzuulus,n Modified: 2007/
. . My Category File Size: 1.1 MB
Displays the last images pecple magesze 210
Data Type: JPG
downloaded. —
= Lock: =]
[ Movies
| ¥ Pictures ¥ Star Rating / My Category.
[’E:"znn?_us_u i
[ 2007_05_12
[72007_05_13
Ej;znnr,os_u
Folder Area Bz00705.37

»| 7 iPhoto Library

Selects a folder to display.

|
Properties Icon (Displays image properties) Control Panel Display Control Panel
Ol Image recorded using the camera’s Stitch Assist mode
: RAW image
B \ovie
[Jd :Image with sound memo attached
[Bx] : Protected image
By :Image recorded using the camera’s AEB function
™  :Rotated image (rotated in display only)

T &9 8
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How to Perform Tasks

Selecting and Using Functions

You can use many ImageBrowser functions by selecting them from the Control Panel
or a menu and then following the instructions in the window that opens.

" Select a function from the Control Panel or a menu.

d ImageBrowser Iaa Edit View Internet Window Help b
2 -
. Close... EQ
£ Save £
Save As... {r38S
\ X New Falder 38BN
Favorite Folders >
[ IMG_0001JPG IMG_0002.JPG IMG_0003JPG IMG_0004JPG Get Info... £
e = =
Copy Image...
VIW|||\$\||| ELGL|EEE Move Image...
Duplicate %D
@ @ @ ‘ ﬁ Rename...
Canon View SlideShow Print & Send to Send to Trash ®a
Camera Image o
Photo Print... Search... 3BF
Index Print...
Layout Print... Export Image...
Create Image for Email... Oganize Image >
Processing RAW Image...
Connect to Camera...
Rewrite Image to Memory Card...

Print > Photo Print... 3P

Layout Print...

Print

806 Photo Print

Printer

(000X 53

Paper size :
A4

Click [Page Setup] to enable
borderless printing on
supported printers.

2 Follow the instructions .. ...
to perform the task. (s o

( Properties... )

Remove unwanted regions ‘ @ Am;ld orlMudify text to print
= | of your photo. with this photo.

El E Image: 1/3 Copies: 17 @ Total : 3 pages

( Close ) ( Print )

#
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Downloading Images

Downloading Images by Connecting the Camera to a Computer

Download the camera images to the computer.

1) IMPORTANT

e The instructions in this software manual assume that you have correctly installed
the software. See the guides supplied with your product package for software
installation procedures.

e If CameraWindow fails to open when you connect the camera, click the
[CameraWindow] icon in the Dock (the bar at the bottom of the desktop).

" Connect the camera to the computer with

the supplied interface cable. D

2 Turn on the camera power, set it to
playback mode and prepare it to
communicate with the computer.

CameraWindow

3 Click [Transfer Untransferred

Images]. 'y ;

: : _ Canon Utilities
The images will start to — | CameraWindow DC
d OWﬂ |Oa d . -.\ :’ [ | erate using the camera:

h the camera buttons.

@ Display Start Screen at Startup

T @& » 10
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When you click [OK] in the dialog that indicates the transfer is complete, the
downloaded images will display in the Main Window.

Acquired Images
W Show All Images

¥ Shooting Date w B =
You can select the newly downloaded s s n"f.fﬂ
images by their shooting dates or My ;::N L g

Category (select models only) classification.
(These are virtual folders.)

@umr;
il Pictures

[ 2007_05.10
d 2007 _05_11
[ 2007 _05_12
p—— « (420070513
|§ : Folders containing - 4z 14
newly acquired images
4 =
-

* Images from memory cards with large numbers of images (more than 1,000) may not download
correctly. If this happens, please use a memory card reader to download.

~ @ HINT

Changing the Download Destination Folder ST S el L L,
The default settings save downloaded images into the [Pictures] folder. EI R
To change the destination folder, select [Operate Images on Camera]
in CameraWindow, then click the button shown on the right, and
select a folder.

T & » 11
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Selecting Images to Download
To download only a selection of images from the camera, select [Operate Images on Camera] in

CameraWindow that first appears and then perform the following procedures.

TJooo Canan Utilities CameraWindow DC - IMC_0005

CameraWindow DC
07/05/14

1 Select images to download.

2 Start the download.

Downloading Using Camera Commands
You can use the camera’s A7 (Print/Share) button to download the images to the computer (Direct
Transfer). See the Camera User Guide for Direct Transfer settings and procedures.

Downloading from a Memory Card Reader
ImageBrowser will start when you insert a memory card into the memory card reader, and display the
following window. Use this window to perform the downloading procedures.

ImageBrowser Canon
: I Downloads all images that have not yet been
[ Download Images J downloaded.

Lets you select and
| download images

| [ Print Menu F— Prints images.

Allows you to select and download images.

Preferences... Exit I

Configures the download folder
and other settings.

- 12
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Printing

Printing a Single Image on a Single Page

Prints one image per page.

w8k Show All images.
il Shooting Date

" Select images for printing. s :
7007 _05_25 File Name. MG
#92007.05.27 Madified- 2007}
@y Category
Myrecple
i Soenery
M events

¥ Pictures
[ z007.05.10
4 zo07 0511
[ zo07.05.02
J 20070513
(4z007.05.14
#2007 05 25
[#zo07 0527
» ! iPhata Library

IMG_002 JA IMG_0003 37
T A A [ ][
Farms &b =] @ . ]
Canon View slidesh Frint & sendto
i i Camera Image il Email Trash
Mo of Images Selected: 1 imagts o

Click [Print & Email], and
[Photo Print] IMC_0002 JPC IMG_0003 |PC IMC_0004 |PC

VG
O A A e || H 3

4 B &

SlideShow

il =5

Photo Print...

- 3 / Total: 5 images i

Layout Print...

Create Image for Email...

LR 13
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3 Set the categories as desired.

Sets the printer, paper 80e Photo Print
size and borderless =
printing settings. 000X )

Paper size :

Ad

‘

Click [Page Setup] to enable
borderless printing on
supported printers.

Sets the Shooting Shooting Date/Time
date/time imprint (None B
Sett|ngs ( Properties... ]
gr;noo:repuhnmw:nted regions ‘ @ m:?;i:d::i:rnl.ext to print
[EIZI Image: 1/3 Copies: [ 1] @ Total : 3 pages
‘ ( Close ) ( Print ) 4
Click here to Click here to insert
crop and print text onto an image
a portion of an and print.
image.
4 Click [Print].
Print window will display.
5 Click [Print].
Printing will start.
- @ HINT |

Laying Out and Printing

You can also select multiple images, add captions and print freely composed layouts on a single page.
Click [Print & Email] in the Control Panel and select [Layout Print]. The shooting date will automatically
appear when you perform a layout print if you click the [ImageBrowser] menu, followed by [Preferences]
and [Layout Print], and place a check mark beside [Shooting Date].

freas 14
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Index Print

Prints an index of the images.

1 Select images for printing.

Click [Print & Email], and
[Index Print].

L IR

Last Acquired Images
il shaw All Images.

v shooting Dare T ke —
) 2007_05_25 File Narne. MG,
#0 20070527 o Modified- 2007}
! i File Size: 1.8 MB
Image Size: v
Data Type: rc
Sound: LL]
Lock: 0

¥ Pictures
{4 2007.05.10
20070511 000
{4 2007.05.12
J 20070513
[ 2007.05.14
(#2007 05 25
#2007 0527
» ! iPhata Library

¥ Star Rating / My Category
o

View | 5F  finrTeal ,.|

— 4 = @ &, 8§
o i Ea) e i i ety

o of Images Salectes 0 [ Tt 0 imager 2

IMC_0002.JPC IMCG_0003.JRC

IMC_0004,JPG

e
-QT @ @ H Selecting Images 'H = 3l
o Y 8

SlideShow Print & Send to

rlluﬂ.u rFrit...
Index Print...
Fwrt Print

Create Image for Email...

- & / Total: 8 images i

15



Set the categories as

Sets the printer, paper
size and number of
print copies settings.

Sets the number of
rows or columns.

Configures the printing of =
the shooting information,
comments, headers,

footers or page numbers.

Click [Print].

Click [Print].
Printing will start.

L IR

Mastering

the Basics

desired. Select an image to rotate or trim.
806 Index Print
Printer Preview

Name:

X000 3
Paper size :

A4

Orientation: Portrait

On printers that support borderless
printing, this feature is not
recommended.Click [Page Setup] to
change this setting.

O
Page Layout Settings

Rows: 3|@
Columns: | 3| @

Page Caption Settings

Copies:

Print window will display.

(< »
| = { ]
™ Shoating Information o Page: i1 o,
Settings... r : =
g | ]

[ Header / Footer a __i!

'l O Rotate Left Rotate Right Trim Image

[ ‘Settings... I

|
( Close ) ( Print

)
4

Rotates selected
images.

Click here to crop a portion of the
selected image and print it.

16
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How to Use CameraWindow

First Window to Open

This is the first screen to appear in CameraWindow.

Canon Utilities
CameraWindow DC

() Operate using the camera:
@ __ 0O
@ Push the camera buttons.

&

Transfer Untransferred Images Downloads all images that have
not yet been downloaded.

A
)

{5 Operate Images on Camera

Closes this window and opens a
camera image browser window that

lets you select and download images.
@ Display Start Screen at Startup
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Screen Showing the Image Index List and Image View

The Thumbnail Window on the left of the screen displays the images on the memory
card in the camera as “thumbnails” or small versions of the images in an index list.
When you select an image from the Thumbnail Window, the image displays in the
View Window on the right.

Aligns the windows. Configurgs ;ettings such as the
@&l thumbnail size and download folder.

™ S\yitches between

Cal’) \\indow display modes. {ej] Configures the name

&l of the camera owner.

Thumbnail Window

CameraWindow DC
07/05/14

View Window

Canon Utilitie§ CameraWindow DC - IM@_0005

@Il Uploads computer
=] images to the camera.

Closes
x CameraWindow.

ey BN Selects all images/images Prints images selected in
L:“L'u not yet downlgaded. ’ & the Thumbnail Window.

n These arrows switch the
image in the View Window.

Downloads images selected
= in the Thumbnail Window.

Use the Help Function
ImageBrowser is equipped with a convenient “Help” function. Use it when you are unsure how to
proceed. To view it, click the [Help] menu and select [ImageBrowser Help].

> 18



Mastering

the Basics

How to Use the Browser Window

Browser Window

This is the main window for performing tasks in ImageBrowser.

Last Acquired Image/Folder Area — Browser Area — Image Information
Selects a folder to display. e Displays the images in Preview Mode: Displays information
* You can register folders you use the selected folder. about the selected image.
often as Favorite Folders (Eﬁ). Index List Mode: Displays image
Register by clicking [Add]. information if you click the [File]
menu and select [Get Info].
eo0e eI - ~
= Last Acquired Images List Mode )
¥ = Show All Images 2
i shooting Date 'V Basic o
[28] 2007 _05_25 File Name: | IMG.
[E] 2007_05_27 Modified: 2007/
vl My Category File Size: 1.1 MB
M People Image Size 2160
[l Scenery Data Type: PG
& Events b, o
] [Favorite Folders | All Folders wck:' Cl
@Mov\es —l
vﬁaﬁclures ¥ Star Rating / My Category
[42007.05.10 iy <N
[#2007_05_11
[72007_05_12
[42007_05_13
[F2007_05_14
[§2007_05_25
[#2007_05_27
D{'j iPhoto Library
IMC_0002 JPC IMCG_0003 JPC IMC_0004 JPG

Ve [ mere T T A A e || 2 3 E Display Control Panel
_— oJ E] @ 2. 0§ Configures the settings
Remove | G = e ey =R for displaying images in
- e e the Browser Area.
Canon Camera = —— Send to Trash
Displays CameraWindow. Deletes selected images or folders
¢ Deleted images are placed in the Trash.

View Image
Displays the selected image in
the Viewer Window.

e If you mistakenly send an image to the
Trash, click the [Trash] icon in the Dock
and restore the image to its original

Slide Show , . folder in the Finder.
Displays the selected images in . .
Print & Email

succession in the window. _ _
Prints the selected image(s).
Or creates an image attachment for email.

Rotate Image

e To rotate images, click the [Edit] menu and select [Rotate Image].

e To rotate the original image in the displayed direction, click the
[Edit] menu and select [Rotate According to Rotation Information].

» Rotate movies by clicking the [Edit] menu and selecting [Movie Edit].

T @ 19
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Browser Area Tasks

Display Mode
Selects a display mode for the Browser Area.
L. W -:: i

1 g i gy

T A e HAE -
. [ = L= B L]
[ =S

Preview Mode: allows the List Mode: allows
image information to be read thumbnails to be viewed at a
while viewing the image. size suited for easy viewing.
- ~ Functions Used in the Browser Area
¥ Basic P s Create New Folder
File Name: . .
= ;,'S:!f,l To create a new folder in the Browser Area, click the
- T [File] menu and select [New Folder].
- . N Select Images

e (O Clicking an image in the Browser Area selects that
image. To select multiple images, hold down the
[shift] key or [88] (Command) key while clicking
images, or hold down the [option] and [shift] key
together and click a starting and ending image to
select a range of adjacent images.

. ¥ Star Rating / My Category

Display Images

Double-clicking an image in the Browser Area (or

selecting the image and clicking ), displays it in

Image

the Viewer Window.

Canon
Camera Image Email Trash

Move, Copy Images

I uflruag p To move an image between folders, drag it over the
destination folder and release the mouse button.

Change the Display Size Show Window To copy an image, hold the [option] key while

You can change the display You can switch between releasing the mouse button as above.

ratio (Zoom mode) or showing/hiding the Folder

thumbnail size (Scroll mode) Area, Control Panel and

with the slider. Information Panel.

@ HINT

Right-Click Context Menus

Right-clicking (or [ctrl] key and clicking) over a window or image displays contextual menus. These menus
contain the functions available in the current context as well as other convenient functions. Use the
context menus to increase your efficiency.

T & » 20
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Viewer (View Image) Window
Double-clicking a thumbnail image in the Browser Window displays it in this window.

006 1l IMG_0001JPG (1/5)

Shooting information

Set the Star Rating.

Change the display
magnification.

Zooming in displays
the Navigator window

to show the relative L rgre 85E, BUR R
position on the image. e g J T R P
Saves an image. - Display the shooting information.
You can configure the
Edit an image. =—— information display by clicking
the [ImageBrowser] menu and
Display multiple m— selecting [Preferences].

images side by side.
Display at full screen size.

e The [Display Original Image] button will display beneath RAW images in the Viewer Window. Click this
button to display the converted image in the Viewer Window.

e Buttons appear beneath movies selected in the Viewer Window, allowing you to replay the movie or adjust
the sound volume. The [Save as Still Image] button will appear above the Star Rating section. Clicking this
button extracts still images from the movie.

T & » 21
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Editing Images

(1) IMPORTANT

* The original image will be overwritten after an image is edited unless the file
name is changed before saving it. To preserve the original image intact, change
the file name when saving the edited image.

e This section introduces the procedures for starting from the [Edit] button in the Viewer Window, but you
can also start the same process by clicking the [Edit] menu and selecting [Edit still image].

Trimming-Cropping a Portion of an Image

Use this to delete unnecessary portions of the image and leave only the necessary
portions.

(?} Rrocedures \

| Double-click an image.

2 [ .| [Edit] and [Trimming
=i | Image].

* You can also input values or an aspect
ratio to specify the trim area.

* Movies and RAW images cannot be
edited.

Color/Brightness Adjustment

Adjusts the images’ RGB values (red, green, blue) and the saturation and brightness.

(% Procedures \

| Double-click an image.

2 [ & _| [Edit] and [Color/
«n | Brightness
Adjustment].

e Movies and RAW images cannot be
edited.

T & » 22
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Red Eye Correction

Restores eye appearance to the original color when light reflected from the flash
makes them appear red.

(% Procedures\

| Double-click an image.

2 [ & _| [Edit] and [Red Eye
ar | Correction].

* Movies and RAW images cannot be
e Click [Start] when Auto Mode is selected. edited.

e Switch to Manual Mode if Auto Mode cannot correct the
image and select the location of the eye to correct.

Inserting Text

Use this to insert text onto the image.

(% Procedures\

| Double-click an image.

2 & .| [Edit] and [Insert
an Text].

e Placing a checkmark in the [Antialias] box
causes the text edges to blend in with
the underlying image.

* Movies and RAW images cannot be
edited.

You can freely adjust the font,
size, color and text attributes.
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Correcting Levels

You can adjust the highlights (brightest portions), shadows (darkest portions) and mid-
tone levels of an image while viewing its histogram.

| “""' (Q Procedures \
- . . | Double-click an image.

@ Level AdjustmentJ
| 2 [ & | [Edit] and [Level

. =i | Adjustment].

e Movies and RAW images cannot be
edited.

Correcting Tone Curves

You can adjust the color balance and brightness of an image using its tone curve
(input/output conversion graph of image brightness).

(% Procedures\

| Double-click an image.

2 ¢ .| [Edit] and [Tone
=i | Curve Adjustment].

£
]

n

e Movies and RAW images cannot be
edited.
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Adjusting Sharpness-Emphasizing Outlines

Makes images appear sharper by emphasizing the outlines of subjects, such as people
and objects.

[Q Procedures \

| Double-click an image.

2 & .| [Edit] and

e | [Sharpness].

e Movies and RAW images cannot be
edited.

Auto Adjustment

Automatically adjusts the image color balance and brightness.

(Q Procedures\

| Double-click an image.

2 ["& | [Edit] and [Auto
an | Adjustment].

e Movies and RAW images cannot be
edited.
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Using Other Editing Software

If you register another image editing program with ImageBrowser in advance, you can
use that software to edit an image selected in ImageBrowser.

Registering an Editing Program

(% Procedu res\

e - ImageBrowser }) File Edit View Internet
within ImageBrowser. 1 —.Q

F [ImageBrowser] and
[Preferences].
ImageBrowser 2 [Register Application]

Editing Images with a Registered Editing Program

it can be started from

Register the program so J

(% PrdCedures

1 Double-click an image.

2 B [Edit] and [Edit
=« | with Registered
Application].

e The shooting information may be lost
from images recorded with the camera
and then processed and saved with
another image editing program.

e Movies and RAW images cannot be
edited.
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Attaching Sounds

You can add sound to images and play back the sounds.

Adding Sound

(% Procedures )

] Select an image.

2 _" ImageBrowsedit View Internet
[File], [Sound] and [Record].

* ImageBrowser's Sound Recorder uses
the Mac OS X recording function. If
required, prepare such equipment as a
microphone, and check that recording
is enabled in the [System Preferences],
[Sound] window.

¢ To delete a recorded sound, click the
[File] menu and select [Sound], followed
by [Send to Trash].

e To record a new sound for an image
that already has one associated with it,
click the [File] menu and select [Sound],
followed by [Record].

D

Symbol displayed on image
thumbnails to which sound
files have been added.

(1) IMPORTANT
¢ Sounds cannot be attached to movies.

Playing an Image Sound File

(% Procedures\

| Select an image.
2 _‘ ImageBrowsedit View Internet
[File], [Sound] and [Play].

* You can also play sounds in the Preview
Mode and the File Information Window.
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Creating Panoramic Images—PhotoStitch

You can create wide panoramic images by moving the camera slightly when recording
a series of images and merging them into one image.

(% Procedu res\

| Select the images that you
want to stitch together.

2 " ImageBrowser File‘ Edit ’View Internet

[Edit] and [PhotoStitch].

e Movies and RAW images cannot be
edited.

Use the PhotoStitch program
to create panoramic images.

@ HINT

Using the Stitch Assist Mode

If you use the camera’s Stitch Assist mode to record the images, PhotoStitch can automatically detect the
image order and merge direction, making it easier to merge the images. (Some camera models may not
feature the Stitch Assist mode.)

Editing Movies

You can create original movies by linking movie clips and still images.
You can even add titles and other text, background music and various special effects
to the movie.

@ (% Procedures\

EEEEEEEEEELY.EEEEENEEENE 1 SeIGCtan image(mOVieor
- e B still image).

lllllll-llllll;lllllll’lll 2 ‘ ImageBrowser File‘ Edit 'View Internet

.- ,EE ,EI ;"3 [Edit] and [Movie Edit].

T IO I TTTT LA TA T * You can configure the default settings
for editing movies by clicking the
[MovieEdit Task] menu and selecting

[Preferences].
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Converting RAW Images

You can convert RAW images to JPEG and TIFF images.

Image type retaining
the detailed image
data from the initial

Image type suited for pasting
into word processing documents
and general programs, and for

(Q Procedures\
| Select a RAW image.

capture. sending email.

2 " ImageBrowsel‘ File kdit View Internet

[File] and [Processing RAW
Image].

JPEG, TIFF...

* You can use the Image Quality
Adjustment Window to adjust the image
brightness and color to your satisfaction.

Exposure correction J Lossless

" White balance adjustment .
image —— —

Color adjustment Jadjustments Color space configuration
possible

~ @ HINT N

About RAW Images

RAW images contain the data captured by the camera’s image sensor without modification. Since they
contain raw data that differs from the usual JPEG images by not having any image adjustment or compression
processing performed in the camera, they can be converted on a computer with a lossless process.

o)

(Image Adjustment)
Standard Image r A _a

. ) ( ) >* Can be used with general programs.
Capture Compression JPEG Image * Image is subject to degradation when

adjusted because it has been compressed.

Processing in the Camera Processing by Computer

Image sensor
data from
shutter release

Image adjustment
& compression

. ImageBrowser
automatically performed

- RAW Image Processing 1
RAW Image Image Adjustment
Capture RAW Image JPEG Image,
Compression TIFF Image

* You can view the image while making
adjustments without worrying about quality oss.
e Processing with ImageBrowser is required to

1 view the images with general programs.
_J

(1) IMPORTANT

* RAW images can only be captured on certain camera models that list “/RAW" as one
of the data types included in the “Specifications” section of the Camera User Guide.
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Exporting
Changing Image (Stills) Sizes and Types

You can change an image’s size and format when exporting it so that it can be
published on the Internet or attached to an email message.

(% Procedures \

| Select an image.

2 .' ImageBrowsel‘ File kdit View Internet

[File] and [Export Image].
3 [Edit and Save Image]
4 [Next >]

e You will lose the shooting information
if you save images as a type other than
JPEG.

Exporting Shooting Information

You can export the shooting information recorded with an image, such as the shutter
speed and exposure, as a text file.

(% Procedures\

| Select an image.

2 .' ImageBrowsel‘ File kdit View Internet

[File] and [Export Image].
3 [Export Shooting Properties]
4 [Next >]

Ascertain the causes of
failed photos or compare the
settings for several images.
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Creating Computer Screen Saver Images

You can export images to serve as computer screen savers.

(?) Procedures\

] Select an image.

2 " ImageBrowsedit View Internet
—

[File] and [Export Image].
3 [Export as a Screensaver]
4 [Next >]

Creating Computer Wallpaper Images

You can export images to serve as computer wallpaper images.

(% Procedures )

] Select an image.

2 @ ImageBrowsedit View Internet
—

[File] and [Export Image].

3 [Export an Image as
Wallpaper]

4 [Next >]
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Extracting Stills from Movies

You can extract and save stills from your favourite frames recorded in a movie.

lIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII (% Procedure \

Xk b m! b s

| Select an image.

2 " ImageBrowser FiIeView Internet

[Edit] and [Extract frames
from a moviel.

shots as stills

Extract your bestJ
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Email

Attaching Images to Email

You can send images as email file attachments.

% Procedures )

You can configure . .
the image size and 1 E < [Print & Email] and

quality settings. rins | [Create Image for
Email].

* You can configure how the email
program automatically starts up by
opening the [Applications] folder, and
double-clicking the [Mail] icon to start
the Mail program, and clicking the [Mail]
menu, followed by [Preferences] and the
[General] tab.

* Images in the [Email Images] folder can
be found by opening the [Users] folder
on the startup disk, followed by the [User
Login Name], [Library], [Preferences],
[ImageBrowserUserData] and [Mail]
folder.
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Slide Shows

Viewing Images in Slide Shows

A multiple selection of images can be shown at full size on the screen in succession as
a slide show.

You can freely configure the N\
transition effects, information % Procedures
displayed and display time settings. 1 & [SlideShow]

SlideShow

‘ — i ' * You can configure the slide show display
- method by clicking the [View] menu and
\ [

selecting [Slide Show Options].

~ @& HINT |
Slide Show Button Functions
The following buttons appear at the bottom of the screen while a slide show is playing.
You can set the Star Rewind == Pause p= Forward
Rating for an image
while it is displayed.  Go to first image -| r Advance to last frame
ey B N = G M » @ .i
1
After the slide show, After the slide show, Stops the slide show.
the images you the images you clicked
clicked during the during the show appear
show remain selected. in a printing window.
\ y,
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Image Management

Changing File Names in Batches

You can change the file names of multiple images in one procedure.

(% Procedures\

| Select an image.

2 .’ ImageBrowsel' File 'Edit View Internet

’ [File], [Organize Image] and
| Shooting Date + Number J [Renamel].
r

* You can change individual file and
folder names by clicking on the file
name in Preview mode or with the File
Information Window.

e Changing the image name in
ImageBrowser also changes the actual
file name on the disk.

Name + Shooting Date + NumberJ Change randomly

T numbered images
Shooting Date + Name + NumberJ and received images

into consecutively
numbered images.
vV —

xxx_03 xxx_05

Sorting Images into Folders by Shooting Date

You can sort images into folders by their shooting dates.

(% Procedures \

] Select an image.

2 .’ ImageBrowsel‘ File 'Edit View Internet

[File], [Organize Image] and
[Sort Images].

3 [The files will be separated
into folders for each
shooting date.]

4 [Next >]

Images predating your use
of ImageBrowser can also
be managed together.

&
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Classifying Images Into Star Ratings Folders

You can classify images according to their Star Ratings into separate folders.

(Q) Procedures\

| Select an image.

2 " ImageBrowsedit View Internet
—

[File], [Organize Image] and
[Sort Images].

3 [The files will be organized
by Star Rating.]

4 [Next >]

—

—

.
\

You can organize the images
you have recorded according
to their Star Ratings.

Lv
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Configuring Image Information Settings

Setting Star Ratings

You can set the Star Ratings used in searching and displaying images in the index list.

(% Procedures\

| Select an image.

2 ([—llnl——U—D List Mode |
Switch to [Preview Model.
3 Set [Star Rating].

* You can also set the Star Ratings by
accessing the [Edit] menu, the File
Information Window or the Viewer
Window.

¢ ¥ ¢ : Ultimate
Yvr :Moderate

w : Okay

Inserting Comments

You can freely insert your choice of text as Comments.

(% Procedures\

] Select an image.
He—— ==

Switch to [Preview Mode].
3 Insert [Comment].

Endless white
sandy beaches

e Comments can also be managed in the
File Information Window.

as comments

Your choice of textJ
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Assigning Keywords

You can set Keywords for use in image searches.

Select keywordsJ

(% Procedure

N

S

] Select animage.

2 ([—---—D ListMode |

Switch to [Preview Model.
3 Set [Keywords].

e Keywords can also be managed from the
[Edit] menu or File Information Window.

* To add keywords,

click the [Edit] menu

and select [Manage] from the [Keyword]

submenu.

- @ HINT

About the Image Information

This chart shows the information other than shooting information that can be added to images.

Information Type | My Category Star Ratings

Comments

Keywords

Rated on basis of 3
rankings: W, Ty,
WX

Categories such as

Content People, Scenery, etc.

Text input without
restriction regarding
the shooting
circumstances

or associated
memories.

Selections are made
from a list (editable)
of keywords, such
as the photographic
subject, place or
action.

Configuration Configured in

Configured in ImageBrowser

Method Camera

Used in Searches — 0 0 0
Used as Filter 0 0 o o
Criteria

Display beneath

Thumbnail 0 0 0 -

submenu.

\_

Categories displayed beneath thumbnails can be selected from the [View] menu and [View Settings]

LR
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Searching, Filtering and Sorting Images

Searching Images

You can search images using parameters extracted from the information associated
with them.

Q} Procedures\

" .' ImageBrowsel‘ File 'Edit View Internet

[File] and [Search].

e After a search, the correlated images
display in the [Search Results] folder.

| " ¥

Favorite photo Date J Saa‘ Results

Keyword Comment J Tﬁﬁ p

7 2007_05_10
" [F2007.05_11
| 2007_05_12
|7 2007_05_13
| 2007_05_14

All Folders |

@ HINT

Tasks Related to Search Results
You can select images in the [Search Results] folder and perform operations on them, such as printing or
copying them to other folders.

(1) IMPORTANT

e Please note that deleting an image from the [Search Results] folder deletes the
original image. Use caution in deleting items from this folder.
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Filtering Images

You can use filters to display only images meeting the selected parameters in the
Browser Area.

Q Procedures\

1 Jf  Filter Tool -

[Filter Tool]

This section is used to specify the filter criteria.

Sorting Images

You can sort images in the Browser Area based on the specified parameters.
Q Procedures )

c LA LES
- - =7 " " ImageBrowser File Edi nternet
/-
File Name | . [View] and [Sort].
Shooting DatelTimeJ

Ascending/
Descending

File Modification

File Size
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Comparing Images

Comparing Multiple Images

When a good photo opportunity arises, you can shoot the same subject using different
shutter speeds and exposures. In ImageBrowser, it is easy to compare images so that
minute differences can be detected.

Select several images to
compare.
2 [View Image]

Wiew
Image

| 3 Select a view method
urt e | from [Number of
Displays].

& | [Synchronize]

Synchranize

806 [ 2007_05_14

e Selecting [Synchronize] causes actions
such as increasing/reducing the
magnification level or scrolling around
the image to apply to all of the selected
images in lock step, making it easy to
check minute details of focus, coloring
and other image characteristics.

IMG_0003_2.JPG (2/2)

<« ﬁdi@%a

-
Show Shaoting
Info i

Back Next Save Edit Synchronize ull Screen

Image Size: 2160 x 1440 | I ‘ Display 75% 4

Actions, such as scrolling or changing the magnification, are performed
on both images no matter which image it is performed upon.
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Remote Shooting

Operating the Camera Using Computer Commands

You can activate the shutter of a connected camera from the computer.

¢

Connect the camera to the
computer.

Turn on the camera power,
| and set it to playback mode.

3 If CameraWindow opens,

click [Operate Images on
| Camera], followed by [X].

1 Open the [Applications]
folder, [Canon Utilities]
folder, [CameraWindow]
folder, and double-click the

| [RemoteCapture DC] icon.

- A ] Also useful for fixed position
4| or unmanned recording.

1) IMPORTANT

e Remote shooting is only available with certain camera models that list it as one
of the features in the “Specifications” section of the Camera User Guide.

e Ensure that you turn off your computer’s Sleep feature before you begin remote
shooting. The results cannot be guaranteed if the computer enters Sleep mode
while remote shooting.

e Except for the shutter button, the camera’s buttons and switches, including
the zoom, cannot be manually operated while the camera is being remotely
controlled.

e The time lag between pushing the shutter button and the release of the shutter
is slightly longer for remote shooting compared with the normal mode of
operation.
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Remote Shooting Window

‘a0 R
(©) Hide ViewFinder
e Hide shooting details

Selects the image’s recording
size and compression.

Release

emoteCanture DC_
el (o :)

1 Add comments shown below

You can add a comment
to an image.

[l
|

Viewfinder

L=

z—f—FHd‘ngHﬂnH Shooting settings j-————\

D —

Focusing Point:

- [off B
Macro: FlashQuality: ’
. . "off [ B,
Sets the shooting settings. o 2 & :
| . On i |
AF operation:
‘ [AF unlock M

Sets the rotation setting of the
image being recorded.

This setting cannot be adjusted
if the [Auto Rotate] function of
your camera is set to [On].

Releases the camera shutter (you
can also release it by pressing
the camera’s shutter button or
the space bar on the keyboard).

Sets the camera’s zoom.

Turns the viewfinder
display on or off.

Resets the exposure, focus
and white balance settings.

~ @ HINT N
Interval Timer Shooting
This method captures a set number of frames recorded at set intervals of time. Click the [Shooting] menu
and select [Interval Timer Shooting]. (Short intervals may be insufficient for image transmission and saving,
resulting in the failure to capture images at the specified interval.)
Timer Shooting
This method captures a single image after a set number of seconds. Click the [Shooting] menu and select
[Timer shooting]. The timer interval settings range from 2 seconds to 30 seconds.
Displaying Subjects on the Camera’s LCD Monitor
You can use the camera’s LCD monitor or a television connected to the camera to view the subject while
shooting remotely. Click the [Camera] menu and select [Camera Display Settings]. See the Camera User
Guide for TV connection instructions.
Shooting Without Worrying about Memory Card Capacity
Clicking the [RemoteCapture DC] menu and selecting [Preferences] opens the Preferences window. If you
place a check mark beside [Computer only] in the [Save Images On] section, you can continue recording
without worrying about free space on the camera’s memory card.

J

LR
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My Camera Settings

Changing the Shutter Sound and Start-Up Image

The camera’s start-up image, start-up sound, shutter sound, operation sound and self-
timer sound are collectively referred to as My Camera Settings. You can register your
own custom images and sounds as the My Camera Settings.

My Camera Settings
e Start-up Image

e Start-up Sound

e Operation Sound
e Selftimer Sound

¢ Shutter Sound

(1) IMPORTANT

e My Camera Settings are only available with certain camera models that list them
as features in the “Specifications” section of the Camera User Guide.

* Do not interrupt the connection between the camera and computer when My
Camera Settings are being transmitted between them.

LR

(% Procedures \

| Connect the camera to the
computer.

27 Turn on the camera power,
and set it to playback mode.

3 If CameraWindow opens,
click [Operate Images on
Cameral], followed by [X].

4 Open the [Applications]
folder, [Canon Utilities]

folder, [CameraWindow]
folder, and double-click the

[MyCamera DC] icon.
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You can register the start-up
image, start-up sound, shutter

sound, operation sound and ——
self-timer sound collectively if | 53

Computer e
you select [Theme]. o

221
321
ANIMALO22

My Camera Settings  =———noz

BASEBALL21

in the computer. CHIMPAN21

ETHDANCE21
ETHTECHN21 x

|
|
( Add... o ( sendtoTrash )

‘( Save to Camera )\ Exit 3

After selecting a My Camera Settings file from the left-hand list,
select a My Camera Settings file to replace in the right-hand list
and click this button, then click [Set to Camera] to register it in
the camera.

~ @& HINT |

Creating My Camera Settings
Comply with the following specifications if you create My Camera Settings in image editing or sound
editing software.

C] a— My Camera Settings

_ registered in the camera.

Start-up images: Compression Method: JPEG (Baseline JPEG)

Data Sampling: 4:2:0 or 4:2:2 Type Duration in Seconds

Pixels (w x h): 320 x 240 pixels 11.025 kHz 8.000 kHz
Sound files: Compression Method: WAVE (Monaural) | Start-Up Sound | 1.0 sec. or less | 1.3 sec. or less

Quantifying Bits: 8 bit Operating Sound | 0.3 sec. or less | 0.4 sec. or less

Sampling Frequency: 11.025 kHz or Self-Timer Sound [ 2.0 sec. or less | 2.0 sec. or less

8.000 kHz (Use the chart on the right | Shutter Sound | 0.3 sec. or less | 0.4 sec. or less

as a guideline for the length of sound
files recorded with the camera.)
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Uploading Images

Uploading Images to a Camera

You can upload images from a computer to a memory card in a camera.

Connect the camera to the
computer.

Turn on the camera power,
| and set it to playback mode.

3 Click [Operate Images on
Cameral.

| Canon Utilities

Show favorite images
to friends or connect
a TV to show them
on a large screen.

Click (Send to Camera).

e |f the Browser Window is open when
the camera is connected (directly
after downloading for instance), open
CameraWindow by clicking the [Canon
Camera] icon in the Control Panel of the
Browser Window.

1) IMPORTANT

e Only images compliant with Design rule for Camera File system standards can be
uploaded to your camera’s memory card.
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Preference Settings

Customizing ImageBrowser

You can configure ImageBrowser to operate according to your preferences.

* Overall coloring, such as
window appearances

* Processing methods for
images shot with the
camera on end

e Categories of shooting
information displayed

e Show/hide messages

* Print settings
* Registering applications I

B2

ftea>n

(% Procedures )

1

" ile Edit View Internet

[ImageBrowser] and
[Preferences].
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Supported Image Types

The following is a list of image types supported by ImageBrowser.,

JPEG

Most cameras use this image type. It compresses at very high ratios, taking advantage
of the characteristics of the human eye. However, because it is an irreversible
compression method (part of the data is lost during compression), if you process and
save an image repeatedly using this method, the image may become rougher.

Exif JPEG is an image type that adds information such as shooting data to a JPEG
image.

RAW

This is a proprietary image type provided by Canon. It allows the output of the image
pixels from a digital camera without any deterioration in the quality of the image.
Some cameras might not support this image type.

PICT

This is the standard image type for Macintosh. This image type is supported by most
Macintosh software.

TIFF

This is a relatively popular image type. It is widely supported by non-Macintosh
programs (such as Windows).

Windows Bitmap
This image type comes standard with Windows. Most Windows programs support it.

QuickTime/AVI
These are movies, which display as a movie icon in the Browser Area of ImageBrowser.
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New Features in This Version

The following features were added or changed in this version of ImageBrowser.
(ImageBrowser Ver. 5.8 to 6.1)

CameraWindow Makeover

CameraWindow has been completely revamped to make the linkage tighter between
Canon brand cameras and ImageBrowser and to add convenience and functionality. It
may not be possible to use the new CameraWindow with some camera models.

Changes to Memory Card Downloading Methods

The Camera Control Window was used in prior versions to download images from
memory card readers. These downloads are now performed as an ImageBrowser
function in the Browser Window. The data reading speed has also been significantly
accelerated.

Text Insertion Feature Added to Printing Functions

In addition to the ability to print such information as the shooting date with the
image, you are now able to add text freely during the printing preparation. Greeting
cards and photos bearing messages can now be made with ease.

Task Button Revisions
The Control Panel Buttons composition has been revised to make the tasks more
intuitive.

e The starting point for the “Create Image for Email” process has shifted from the
[Internet] button to the [Print & Email] button.
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Software User Guide Macintosh (ImageBrowser, PhotoStitch)

Disclaimer

e While every effort has been made to ensure that the information contained in this guide
is accurate and complete, no liability can be accepted for any errors or omissions. Canon
reserves the right to change the specifications of the hardware and software described
herein at any time without prior notice.

e No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language in any form, by any means, without the prior written
permission of Canon.

e Canon makes no warranties for damages resulting from corrupted or lost data due to a
mistaken operation or malfunction of the camera, the software, memory cards, personal
computers, peripheral devices, or use of non-Canon memory cards.

Trademark Acknowledgments

e Macintosh, the Mac logo, QuickTime and the QuickTime logo are trademarks of Apple, Inc.,
registered in the U.S. and other countries.

CDA-E016-010 © CANON INC. 2008
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